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Technical Support
If you have difficulties using Express Zip File Compression please read the applicable topic 
before requesting support. If your problem is not covered in this user guide please view the 
up-to-date Express Zip File Compression Online Technical Support at 

www.nchsoftware.com/zip/support.html . 
If that does not solve your problem, you can contact us using the technical support contacts 
listed on that page.

Software Suggestions
If you have any suggestions for improvements to Express Zip File Compression, or 
suggestions for other related software that you might need, please post it on our Suggestions 
page at www.nch.com.au/suggestions/index.html. 

Many of our software projects have been undertaken after suggestions from users like you. 
You get a free upgrade if we follow your suggestion.

www.nchsoftware.com/zip/support.html
www.nch.com.au/suggestions/index.html
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Introduction
Thank you for installing Express Zip.
Express Zip is an archiving and compression tool to create, manage, and extract zip files.
With Express Zip you can easily create zip files of your important documents, images, music 
and more to save disk space, or to quickly email or burn to a CD.
Features: 
● Quickly create new zip files
● Edit or extract existing zip files
● Email zip files in two easy clicks
● Burn your archives to a CD or DVD for long term backup
● Simple but powerful user interface
System Requirements  
● Windows XP/Vista/7/8/10
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Getting Started
It is very easy to get started using Express Zip for creating or extracting from an archive.
Creating a zip file: 
● Launch Express Zip
● Click the "Add Folders" or "Add Files" button on the toolbar to begin adding the files you 

want to archive
● Alternatively, you can right click a file or folder in File Explorer (or your Desktop) select 

"Express Zip" and then "Compress" option.
Opening an existing archive: 
● Launch Express Zip
● Click the "Open" button and browse to the location of the file you want to open. After you 

have opened a file, Express Zip will display the contents of the archive in the browser 
window.

● Alternatively, you can right click on an archive in File Explorer (or your Desktop) select 
"Express Zip" and then "Open Archive" option.
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What is an Archive?
What is an archive?  
An archive file is a collection of different folders and files that are packaged together so that 
they can be easily moved from one computer to another. Since many people use this method 
for backup purposes, it has gained the name "archive." Further, most archive files are 
compressed in order to save disk space or network bandwidth. A compressed archive must be 
decompressed before the files inside can be used.

By far the most popular archive type -- the one that Express Zip creates -- is a zip file, which 
has the ".zip" file extension.
In addition to creating zip files, Express Zip can open and extract the following file formats:
● .zip
● .jar
● .rar
● .tar
● .gz
● .tgz/.tar.gz
● .7z
● .bz2
● .xz
● .wim
● .zipx
● .pkpass
● .bkz
● .arj
● .lzh
● .cab
● .iso
● .apk
● .nco
● .z
● .img
● .dmg
● .cpio
● .deb
● .qcow2
● .rpm
● .txz
● .vhd
● .vmdk
● .xar
● .zab

4



Creating a Zip Archive
There are a number of ways to create zip archives with Express Zip.
When you launch Express Zip, it will open with a blank zip file that you can begin adding 
folders and files to immediately. To do this, click Add Folder  or Add Files from the toolbar or 
File menu. Express Zip will automatically create the zip file as you add folders or files in the 
location specified in the address bar under the toolbar, and will update the zip file as you 
continue to add files.

Another method for creating zip files is through File Explorer or your Desktop. Right-clicking on 
a folder or file will open a context menu with the option "Express Zip," with the submenu option 
"Compress." After selecting this option, Express Zip will launch and automatically add the 
selected item into a new zip archive. You can then continue to add more folders or files to the 
archive as usual from Express Zip.

When adding items to the archive, you can also drag and drop them into Express Zip from a 
File Explorer window or your Desktop.
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Managing an Archive
After you have created a zip archive as outlined previously, you have several options for 
managing your archive.
Removing folders or files: If there is a folder or file in the archive that you do not want to 
include, you can remove it by simply selecting the item in either the explorer (left pane) or file 
list (right pane) and clicking the Remove  button from the toolbar or selecting Remove  from 
the Edit menu. You can also remove the selected item by simply pressing the delete  key on 
your keyboard. Note: It is not possible to delete the root (topmost) folder from within Express 
Zip. 

Moving folders: You can move a folder from one place to another in the Express Zip explorer 
window. Click and drag the folder you want to move and drop it over the folder you want to 
move it into. Note: It is not possible to move the root (topmost) folder. It is also not possible to 
move a parent folder into a child folder. 

Renaming folders: You can rename a folder using the Express Zip explorer window. Select the 
folder you want to rename and select the Rename  option from the Edit menu. You can also 
click on the folder name of the item selected in the explorer window to edit the name. 
Adding folders or files: If there is a folder or file in the archive that you do want to include, you 
can add it by simply either use the Add File/Add Folder  button (Ctrl+T /Ctrl+F ) and selecting 
the item you want to add or select the item in the file explorer and drag it to the file list (right 
pane). Though not all archive types have this functionality, here are the 7 formats where Add 
File/Folder functionality is supported: 
● .zip
● .7z
● .tar
● .tgz/.tar.gz
● .wim
● .lzh
● .arj
Note: It is not possible to add files/folders with special characters to .arj archives. Either 
rename the file manually or let ExpressZip rename it inside the archive with 
Renamed_File/Folder 

Compression Level: Express Zip can use several different levels of compression when creating 
a zip file. If you want to change the degree of compression to compress zip files and be able to 
efficiently email them, you may do so by going to the menu tab and clicking on "File"

A dropdown will appear and from here, you can choose the Compression Level option and 
select from Fastest, Fast, Normal, Small, or Smallest.
Be advised that these options vary in accordance with the amount of compression to be made, 
as well as the varying speed in which your compressed files will be processed. With the 
"Fastest" option equivalent to processing the compression in the fastest possible time but not 
the smallest possible compression size, and the "Smallest" option equivalent to compressing 
the file in the smallest possible size, yet will take more time to process.
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Extracting an Existing Archive
Extracting files from an archive: 
Express Zip can be used to extract (also commonly known as "uncompress" or "unzip") files 
that are contained in a zip archive. Clicking on the Open button on the toolbar or selecting the 
Open option from the File menu will open a browser window where you can select a zip file to 
open.

You can also open an archive by right clicking on it in File Explorer or from your Desktop and 
selecting the Express Zip->Open Archive  option from the context menu.
After you have opened the zip file, Express Zip will display the contents of the archive and you 
can browse through the folders and files.
To extract the archive's contents to your computer, click the Extract button on the toolbar or 
select the Extract option from the File menu. Express Zip will open a window with options to 
customize the extraction process.

Note: If you want to extract only certain files or folders from the archive, select the items from 
the explorer window or the file list window and click Extract Selected.
Extraction options:  
Before extracting, Express Zip will open an options dialog window so that you can tailor how 
the extraction process proceeds. The following options can be set from this window:
Extract Location:
Express Zip will create a new folder in your selected location and extract the contents there. 
Express Zip will use the archive name for the new folder so that it will be easy to find (e.g., if 
the archive name is MyArchive.zip, the new folder name will be MyArchive).
● Extract to this location: This option allows you to determine where the archive's contents 

will be placed on your computer. Click the Browse...  button to choose a different location.
File Conflicts:
File conflicts occur when a file you are extracting has the same name of a file already in the 
extract location. You can use one of the following options to resolve the conflict:
● Overwrite all files: Express Zip will simply overwrite any pre-existing files with the files from 

the archive.
● Only overwrite if the archive file is newer (fresher): If this option is selected, Express Zip 

will compare the modified date and time of the archive file with the existing file and 
overwrite it only if the archive file is newer.

● Prompt before overwriting: If this option is selected and a conflict is found during extraction, 
Express Zip will present you with the name and date of the files and ask you if you want to 
overwrite the existing file or to skip it.

● Don't overwrite any files: Express Zip will not overwrite any existing files if this option is 
selected.

Note: File conflicts do not pertain to folders. If a folder already exists, any files in that folder will 
remain unchanged (unless there is a file conflict).
Extraction: 
When you have finished specifying your extraction preferences, click the Extract button to 
begin extraction. This process will proceed automatically unless there is a file conflict that you 
need to be asked about. Express Zip will display a progress window to show the approximate 
amount of work done.
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Working with Split Zip Archives
Viewing/Extracting split zips: 
A split zip archive consists of multiple files. One file will have a ".zip" extension. The rest of the 
files will have extensions ".z01, .z02, ...etc". Its important that all these files are in the same 
folder when reading and extracting the multi-part archive, otherwise you may run into errors. 
Click on the file with the ".zip" extension to view the multi-part archive. You can then extract the 
archive like any other Zip archive. 

NOTE: ExpressZip does not allow you to edit a split zip archive(add or remove files). 
Creating split zips:  
Often things like email servers have a maximum size for files that can be sent so you may 
need to split up your zip into smaller parts that can be sent. To create a multi-part (split zip) 
archive you must first open a Zip file (.zip extension) that is not already a multi-part archive. 
Then click the "Split" option under "Tools". Identify the file to save to, select a split size, and 
click "Split Zip". If you want to overwrite the existing Zip file with the multipart archive, simply 
use the default save file name and click "Yes" when prompted about the overwrite. 

NOTE: This process will create multiple files with the same name but different extensions. One 
file will have a ".zip" extension and the rest will have extensions ".z01, .z02, ...etc". Keep these 
files together. 
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Email an Archive
You can email an archive as an attachment to any email address. This is very useful in quickly 
sending batches of files to another computer.
To send the archive you are currently working on as an email attachment, click the Email 
button on the toolbar or select the Email option from the Tools menu. Express Zip will open a 
window with options to customize your email.

Note: Express Zip will require Email Settings to be set up before an archive can be emailed. If 
you have not already done so, you will be prompted for your email settings before proceeding.
Email Options:  
Express Zip will open a dialog window with email options that can be set before sending your 
archive. This manages how the attachment is sent, who the email goes to, and the subject and 
body of the email.

Send To: Enter the recipient of the email. 
Message Content:
● Subject: Any text you enter in this line will appear as the subject of the email.
● Body: Any text entered into this box will appear as the body of the email.
Keep these settings as my defaults: If this box is check marked, the information entered will be 
saved for the next time an archive is sent.
Email Settings: Clicking this button will open the Email Settings dialog window where changes 
can be made to the email server, sending address, etc. See Options ~ Email for more details 
on this window. 
Emailing Split Zips: 
You can also open and email split zips with ExpressZip. When emailing split zips you will get 
an additional dialog asking you how you want to email the multi-part archive. 
● Send all parts together: Selecting this option will attach all the split zip's parts to a single 

email and send them together. Take note that only the first and last part of the mail will 
contain the message body. Other parts will have empty message. 

● Send one email for every part: Selecting this option will send each part with its own email. 
The part number will automatically be appended to the subject. 
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Email Settings
These settings are used to set up an email server for emailing an archive directly from Express 
Zip. These settings must be configured before the email option can be used. 
Send Method 
● Send using a SMTP server: Select this option if you want to use an SMTP (Simple Mail 

Transfer Protocol) server to send email. A SMTP server is typically provided by an Internet 
Service Provider or a company IT department. 

● Send directly (work as own email server): Select this option if you do not have access to a 
SMTP server or if you do not know your SMTP server name or password. 

SMTP Options:
● SMTP host: This is the address of your SMTP server (e.g., mail.mycompany.com) 
● Server requires authorization: Check mark this box if your SMTP server requires 

authorization before an email can be sent. Most SMTP servers will require an authorization. 
● Username: This is the SMTP authorization name. 
● Password: This is the password associated with the SMTP username. 
● Attempt to send directly if SMTP connection fails: If this box is checkmarked, Express Zip 

will attempt to work as its own email server if the SMTP server is unavailable. Note: 
Express Zip will not make this attempt if the SMTP authorization fails. 

Message Settings Options 
Use these options for setting up the way emails are sent by default. Emails can be altered 
before they are actually sent, but customizing these options can make it quicker to send emails.
● Default reply email: This is the reply to email address that will be used when emailing an 

archive with Express Zip. This is generally your email address, but can be used with the 
server's "no reply" address or any other address. 

● Use custom address for sending email: If this box is check marked, Express Zip will 
automatically populate the "Send To" field when the Email window is opened. 

● Send to address: This is the email address that will automatically be populated into the 
"Send To" field when the Email window is opened. 

● Use custom subject and body: If this box is checkmarked, Express Zip will automatically 
populate the subject and body fields when the Email window is opened. 

● Subject: This is the custom subject that will be used when the Email window is opened. 
● Body: This is the custom body that will be used when the Email window is opened. 
Problems when sending email using our software  
If email is not being sent correctly, please review the "Email Settings" (available from the 
software's Options or Preferences dialog). Most problems result from incorrect email settings, 
most often because the ISP SMTP server has not been entered, or is missing a port number 
after the server address.

You can refer to this page for further details - https://www.nch.com.au/kb/10018.html 
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Convert to Zip/7zip/Tar/Tgz/Wim/Arj/Lzh Archive
Although ExpressZip supports a number of different archive formats (.zip, .cab, .rar, .tar, 
.tgz/.tar.gz, .gz, .7z, .img, .dmg, .apk, .pkpass, .bz2, .wim, .xz, .z, .zipx, .bkz, .jar, .nco, .zab, 
.iso, .arj and .lzh), only seven (7) formats are editable: the zip format (.zip), the 7zip format 
(.7z), the Tar format (.tar), the TarGz format (.tar.gz/.tgz), the Wim format (.wim), the Arj format 
(.arj) and the Lha format (.lzh). To convert any of these archives to a zip archive you must first 
open the archive. Then click the menu button "Convert to Zip/7z/Tar/Tgz/Wim/Arj/Lzh Archive" 
under "Tools" or use the "Convert" Toolbar. Specify the location of the new zip archive and 
click convert. 

Note: If the archive has encryption you will be asked for the password and if the file to convert 
to (zip, 7z, wim, arj) is encryptable, the converted file will also be encrypted. 
Merge 
A split-zip archive is one that has been separated into multiple smaller pieces. It cannot be 
edited while in this state. The Merge tool is used to recombine these pieces into a single .zip 
file which can then be edited. Specify the location for the combined archive and click convert. 
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Create Self-Extracting Zip Archive
By creating a Self-Extracting Zip Archive, you can allow your archive to be unpacked 
anywhere, without relying on the end recipient having access to an archive utility. 
Note: If you change the contents of the original archive, you will need to recreate the 
Self-Extracting archive if you wish it to reflect these changes. 
When creating a Self-Extracting archive, you will need to select whether you wish to create it 
for either Windows or Apple. The same Self-Extracting archive will not function on both. 
(Simply create one of each if you need to.) 
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Quick Zip Menu
The Quick Zip menu allows you to quickly zip the contents of common folders. The following 
selections can be made from the Quick Zip menu, found in the Tools menu:
● Documents: All of the contents of the computer's Document folder will be added.
● Music: All files and folders in the computer's Music folder will be added.
● Pictures: All files and folders in the computer's Pictures folder will be added.
● Videos: All files and folders in the computer's Videos folder will be added. Note: this menu 

option will only be available in Vista or newer.
Note: The location and name of these folders varies from computer to computer depending on 
the operating system. For instance, on Windows XP the Documents folder may be 
C:\Documents and Settings\Admin\Admin's Documents while on Windows Vista it may be 
C:\Users\Admin\Documents. However, Express Zip is able to detect these folders 
automatically. Express Zip does not filter the contents of these folders, instead all content of 
the selected folder are added to the archive (e.g., non-picture items in the Pictures folder will 
be added).
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Encryption
Encrypting Archives:  
Encryption will add a password to the zip file so that only those who know the password will be 
able to extract the files it contains. This is useful for archiving sensitive files that are stored on 
a computer with multiple users, sending archives over unsecured networks, or placing archives 
on media which is easily stolen like a DVD or thumb drive.

To encrypt an archive, click the "Encrypt" button on the toolbar or select Tools->Encrypt from 
the menu. This will open the Encryption Manager, which has three options:
● Add password protection to the archive: Use this option if the zip file you are working on 

does not already have encryption. Enter the password into the "New Password" field and 
retype it in the "Retype New Password" field.

● Change the current password: Use this option to change the password. Enter the current 
password into the "Current Password" field and enter the new password into the "New 
Password" and "Retype New Password" fields.

● Remove the current password: Use this option to remove the password and encryption 
from the archive. Enter the password into the "Current Password" field.

Currently, the following are the archive types that can be encrypted/decrypted by ExpressZip 
● .zip
● .7z
● .arj
● .wim
Note: If WinRAR is installed on the user's PC, ExpressZip allows encryption/decryption for .rar 
files 
Note: Passwords are only limited up to 256 characters 
Opening an encrypted archive: 
Depending on the format, most encrypted archives can be opened and browsed without 
providing a password. However, a password will be needed before files in an encrypted 
archive can be extracted or opened. Archive formats do not have any way to recover a 
password, so it is very important to remember the password associated with the archive. 
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New Folder
Creating New Folder to Zip Archives: 
Creating new folder to zip archives can be done via the "File" menu item, "New Folder" option. 
This functionality creates a blank folder to the zip archive.
Note: This functionality is disabled for all other archives 
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Adding File(s)/Folder(s)
Adding File(s)/Folder(s) to Archives: 
Adding file(s)/folder(s) can be done via the toolbars option, via the "File" options or via 
dragging to list view. There are only seven (7) formats though that can be edited: the zip format 
(.zip), the 7zip format (.7z), the Tar format (.tar), the TarGz format (.tar.gz/.tgz), the Wim format 
(.wim), the Arj format (.arj) and the Lha format (.lzh)

Limitations:  
There are some limitations to adding file(s)/folder(s)
● Three (3) formats can't handle adding empty folders: .7z, .arj, and .lzh
● .arj format can't handle adding file(s)/folder(s) with special characters in its(their) filename. 

ExpressZip would prompt files with special characters to rename it to 
Renamed_File.ext/Renamed_Folder
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Removing File(s)/Folder(s)
Removing File(s)/Folder(s) to Archives: 
Removing file(s)/folder(s) can be done either via clicking in the list view or the tree view. There 
are only seven (7) formats though that can be edited: the zip format (.zip), the 7zip format (.7z), 
the Tar format (.tar), the TarGz format (.tar.gz/.tgz), the Wim format (.wim), the Arj format (.arj) 
and the Lha format (.lzh)

Note: Removing all file(s) and/or folder(s) in .arj and .lzh formats makes the archive invalid and 
removes the archive itself.
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Working with Par2 Tool
Archives can be damaged upon download or recreation. Furthermore, split archives can also 
have missing parts. If ExpressZip cannot open the archive due to either the archive is 
damaged or the split archive has missing files, it now has an option to try to repair those files 
provided that there are par2 recovery files

Par2 is a tool for creating and/or using PAR2 files to detect damage in data files and repair 
them if necessary. This can be used for any type of archive, especially split archives. There are 
three options a user can choose on what to do with par2
● Create par2 files for the archive/split archive: Use this option to create a par2 recovery file. 

A user can create a par 2 file for the large single archive and then split the archive via split 
option and still can use the .par2 files as a recovery file for the split archive. There are 2 
parameters a user can use for creating par2 files, % redundancy and block size. By default, 
% redundancy is at 5% while block size is left to the tools computation how much block 
size is necessary. A user may wish to input custom numbers to the 2 parameters by 
choosing the custom option in the dialog's drop down

● Verify par2 files: Use this option to check if the damaged archive/split archive can be 
repaired. ExpressZip will prompt the user if the damaged archive/split archive is repairable 
or not. If repair is not possible, it will prompt how many more recovery blocks out of total is 
needed.

● Repair the damaged archive/split archive with the par2 files: Use this option to repair the 
damaged archive/split archive. For split archives, the missing part of the multipart will be 
recreated. 

Note: Since creation, verification and repair includes complex operations like computation of 
checksums, the process will take somewhat long time to finish.
Note: The .par2 files should be on the same directory and the same base name as the 
damaged archive when dealing with verify and repair options. For example:
● Archive Name: C:\Users\Admin\Desktop\MyFiles\Par2Split.zip
● Par2 Name Should be: C:\Users\Admin\Desktop\MyFiles\Par2Split.zip.par2
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Compress with Prism/Pixillion/Switch
Though ExpressZip can compress video, image, and sound files, there are other NCH 
products solely intended to compress the said types of files. These features can be accessed 
in ExpressZip via Right Click options. 
● Compress Video Files with Prism
● Compress Image Files with Pixillion
● Compress Sound Files with Switch
Upon choosing one of these features, ExpressZip extracts selected video, image or sound files 
to the default extraction folder, installs Prism, Pixillion or Switch, if program is non existent and 
launches the program. 
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Shortcut Keys
The following shortcut key combinations can be used in Express Zip to save time
Ctrl + F  Add Folder
Ctrl + N  New Zip Archive
Ctrl + T  Add File
Ctrl + L  Open Archive
Ctrl + E Extract All
Ctrl + Shift + E  Extract Selected
Ctrl + A  Select All
Ctrl + C  Copy
Ctrl + V Paste
Delete Remove Selected Item(s)
F2 Rename Selected
Alt + F2 Rename Archive
Ctrl + O Options
Alt Show Full Menu
F1 Open the Help Documentation
Alt+F4 Exit Express Zip
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Options ~ General
Various settings can be configured from this page which affect how Express Zip works. Click 
the Options button in the toolbar and select the General tab to open these settings. 
Default File and Folder:
● Default zip name: This is the name that Express Zip uses when it creates a new zip file.
● Default save location: This is where a new zip file will be saved. Click the Browse  button 

to change this location.
Right Click Context Menu:
Note that you must be logged on as an Administrator before you can change any of the 
right-click settings in Express Zip.
● Add Express Zip to the File Explorer right click context menu: If this box is checkmarked, 

Express Zip can be accessed through the File Explorer context menus. If a file or folder is 
right-clicked, an option to zip the file or folder with Express Zip will be present in the 
Explorer context menu. Similarly, if an archive file is right-clicked an option to open the 
archive with Express Zip will be present (if multiple files are selected, Express Zip will use 
the parent folder as the name).

● Save zip file in the original folder or file location: If this option is checkmarked, the new zip 
file will be created in the same location (folder) as the original folder or file. Otherwise, the 
new zip file will be located in the default save location.

Quick Zip:
● Don't prompt me when using Quick Zip: If this option is checkmarked, Express Zip will use 

one of the two options below to determine how to zip the folder selected in the Quick Zip. 
Otherwise, Express Zip will ask you if you want the selected folder to be added to the 
current archive or if you want to create a new zip file. 

● Always create a new zip file for Quick Zip items: If this option is selected, Express Zip 
will create a new zip file when a folder from the Quick Zip is selected. 

● Always append Quick Zip items to the current zip file: If this option is selected, Express 
Zip will append the folder selected from the Quick Zip to the current zip file. 

Ignore Files
● Ignore hidden files: If this option is checkmarked, Express Zip will not show and/or archive 

hidden files or folders 
● Ignore with these extensions: If this option is checkmarked, Express Zip will not show 

and/or archive files with certain extension type. For now, .db files are the only type that can 
be ignored 
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Options ~ File Associations
Express Zip supports various archive types (.zip, .rar, .cab, .dmg, .arj, .lzh, .vmdk, .apk, .bz2, 
.cpio, .deb, .tar, .tgz, .txz, .gz, .gzip, .7z, .iso, .img, .pkpass, .qcow2, .rpm, .wim, .vhd, .vmdk, 
.xar, .xz, .z, .zipx, .bkz, .jar, .zab, and .nco) and can be associated with these types based on 
their file extension(s). When a file type is associated with Express Zip, it will be automatically 
opened in Express Zip by default. 

The Archive Types group box contains a list of the archive types supported by Express Zip. 
Check each file type that is to be associated with Express Zip.
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Options ~ Other
● Prompt for Open or Create whenever Express Zip is run: If this item is checked, Express 

Zip will prompt to either open an existing archive or create a new archive when launched. If 
this item is unchecked, Express Zip will create a new archive when launched. 

● Open folder browser after unzipping using right click option: If this item is checked, Express 
Zip will open an explorer window pointing to where the files were extracted. 

● Prompt for Prism Video Compression Software: If this item is checked and a video file is 
added that can be converted to a smaller format, a prompt will come up asking whether or 
not you want to use Prism to convert the video file before adding it to the archive. 

● Prompt for Switch Sound Compression Software: If this item is checked and a sound file is 
added that can be converted to a smaller format, a prompt will come up asking whether or 
not you want to use Switch to convert the sound file before adding it to the archive. 

● Prompt for Pixillion Image Compression Software: If this item is checked and an image file 
is added that can be converted to a smaller format, a prompt will come up asking whether 
or not you want to use Pixillion to convert the image before adding it to the archive. 

● Reminder to rip cda files before adding them to an archive: If this item is checked and a 
cda file is added, a prompt will come up asking whether or not you want to use Express Rip 
to rip the track to another format before adding it to the archive. 
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Command Line Options
You can run ExpressZip from the command line. Any or all options can be used and repeated 
as needed. No prompts occur when using command line options. The following options are 
available:

zip: Archive files/folders into a zip. 
● -a "archive-path"  the path of the resulting archive. 
● -f "files/folders" one or more folder/file paths to add to the archive. Must enclosed in quotes 

and separated by spaces. 
● -o this option overwrites any existing archives.
● -p "password"  adds encryption to the archive with this password. 
● -cx, -cf, -cn, -cs, -ct a compression level respectively: fastest, fast, normal, small, smallest.
Example:  "C:\Program Files\NCH Software\expresszip.exe" zip -a 
"C:\MyDocuments\archive.zip" -f "C:\MyDocuments\Music" 
"C:\MyDocuments\Pictures\sample.jpg" -cn -o 

extract:  Extract files from any of the archives supported by ExpressZip. 
● -a "archive-path"  the path of the archive to extract. 
● -d "output-directory" the directory to extract the files to. 
● -o when specified, will overwrite any existing file when extracting.
● -p "password"  password to the archive if applicable. 
● -m when specified, will make a new folder in the output directory with the name of the 

archive.
Example:  "C:\Program Files\NCH Software\expresszip.exe" extract -a 
"C:\MyDocuments\archive.zip" -d "C:\MyDocuments" -m 
convert: Convert any of the archives supported by ExpressZip to a zip archive. 
● -a "archive-path"  the path of the archive to convert from.
● -d "output-directory" the output directory to convert the archive to (the name will be the 

same as the input archive, the extension will be .zip).
● -o this option overwrites any existing archives.
● -p "password"  password to the archive if applicable.
Example:  "C:\Program Files\NCH Software\expresszip.exe" convert -a 
"C:\MyDocuments\archive.rar" -d "C:\MyDocuments" 
encrypt: Add encryption to a zip archive. 
● -a "archive-path"  the path of the archive to encrypt. 
● -p "password"  the password to add to the archive. 
Example:  "C:\Program Files\NCH Software\expresszip.exe" encrypt -a 
"C:\MyDocuments\archive.zip" -p "myPassword" 
decrypt: Remove encryption from a zip archive. 
● -a "archive-path"  the path of the archive to remove encryption from. 
● -p "password"  the password to the encrypt archive. 
Example:  "C:\Program Files\NCH Software\expresszip.exe" decrypt -a 
"C:\MyDocuments\archive.zip" -p "archivePassword" 
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Additional Apps
When working with large and complex files like video, sound, and image files you may want to 
first convert those files into a more optimal format before adding them to an archive. Use these 
applications with ExpressZip to maximize your compression while maintaining the quality that 
you need in your files.

Prism Video Converter Software: 
● Convert or compress video files within minutes of downloading 
● Universal video converter supporting all popular formats 
● Includes batch video conversion  to convert thousands of files 
● Download Prism Here 
Doxillion Document File Format Converter:  
● Convert between many different text document formats 
● Quick and easy one-click document convert process 
● Batch convert thousands of files at once 
● Download Doxillion Here 
Pixillion Image Converter Software: 
● Convert between many different image file formats 
● Rotate, resize, adjust quality, add captions and watermarks, and more... 
● Batch convert thousands of files at once 
● Download Pixillion Here 
Switch Audio File Converter Software:  
● Universal audio converter  supporting all popular formats 
● Convert or compress  sound files within minutes of downloading 
● Includes batch audio converter to convert thousands of files 
● Extract audio  from any media file including video 
● Download Switch Here 
Express Rip CD Ripping Software: 
● Fastest CD Ripping software available using proprietary optimization technology 
● Rip your collection to wav or mp3 quickly and easily. 
● Includes online database access  to automatically obtain track and album information. 
● Extract audio  from many other formats as well, including wma, m4a, aac, aiff, and more. 
● Download Express Rip Here 
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NCH Software Suite
This is a useful way to browse all the software available from NCH Software
You can see a set of products by type like Audio, Video and so on and view the product. From 
there you can try out the product and it will download and install it for you to trial. If you already 
have the product installed then you can click "Run It Now" and the program will be launched for 
you.

There is also a list of features for products in the category. Click on a feature, such as "Edit a 
Video File", to install a product with that ability.
Search  
Search our website for products matching any keywords you type. 
See more of our software  
Browse our website for more software. 
Subscribe to our newsletter 
You can subscribe to our newsletter for announcements of new releases and discounts. You 
can unsubscribe at any time. 
See the latest discounts for purchase  
See the latest discounts we are offering for purchasing our products. 
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Software License Terms
Our goal is for every user to have a successful experience with our software. We offer it to you 
on the basis that you accept our End User License Agreement (EULA).
This EULA limits our liability and is governed by an arbitration agreement and venue 
agreement. Please read below as these terms affect your rights.
1. The copyrights in this software and any visual or audio work distributed with the software 
belong to NCH Software and others listed in the about box. All rights are reserved. Installation 
of this software and any software bundled with or installed-on-demand from this software, 
including shortcuts and start menu folders, is licensed only in accordance with these terms. 
These copyrights do not apply to any creative work made by you, the user.

2. By installing, using or distributing the software you, on your own behalf and on behalf of your 
employer or principal, agree to these terms. If you do not agree to any of these terms, you may 
not use, copy, transmit, distribute, nor install this software - return it to the place of purchase 
within 14 days to receive a full refund.

3. This software, and all accompanying files, data and materials, are distributed "as is" and with 
no warranties of any kind, whether express or implied except as required by law. If you intend 
to rely on this software for critical purposes you must test it fully prior to using it, install 
redundant systems and assume any risk.

4. We will not be liable for any loss arising out of the use of this software including, but not 
limited to, any special, incidental or consequential loss. Your entire remedy against us for all 
claims is limited to receiving a full refund for the amount you paid for the software.

5. You may not use this software in any circumstances where there is any risk that failure of 
this software might result in a physical injury or loss of life. You may not use this software if you 
do not regularly backup your computer, or do not have antivirus and firewall software installed 
on the computer, or keep sensitive data unencrypted on your computer. You agree to 
indemnify us from any claims relating to such use.

6. You may copy or distribute the installation file of this software in its complete unaltered form 
but you may not, under any circumstances, distribute any software registration code for any of 
our programs without written permission. In the event that you do distribute a software 
registration code, you will be liable to pay the full purchase price for each location where the 
unauthorized use occurs.

7. Use of data collected by the software is subject to the NCH Software Privacy Statement 
which allows automatic anonymized collection of usage statistics in limited circumstances.
8. Choice of Law. If you reside in the United States, your relationship is with NCH Software, 
Inc, a United States company, and this agreement is governed by the laws and courts of 
Colorado. If you reside anywhere in the world outside of the United States, your relationship is 
with NCH Software Pty Ltd, an Australian company, and this agreement is governed by the 
laws and courts of the Australian Capital Territory. Such courts have continuing and exclusive 
jurisdiction over any dispute between you and us, regardless of the nature of the dispute.

9. U.S. Customers Only: Arbitration Agreement and Class Action Waiver: PLEASE READ THIS 
CAREFULLY. IT MAY AFFECT YOUR RIGHTS.
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If you reside in the United States, NCH Software and you agree to arbitrate all disputes and 
claims between us. This agreement to arbitrate is intended to be broadly interpreted. 
References to "NCH" "you," and "us" include our respective subsidiaries, affiliates, agents, 
employees, predecessors in interest, successors, and assigns. This arbitration agreement 
does not preclude you from bringing issues to the attention of U.S. federal, state, or local 
agencies. Such agencies can, if the law allows, seek relief against us on your behalf. This 
Agreement evidences a transaction in interstate commerce, and thus the Federal Arbitration 
Act governs the interpretation and enforcement of this provision. This arbitration provision shall 
survive termination of this Agreement.

A party who intends to seek arbitration must first send to the other, by certified mail, a written 
Notice of Dispute ("Notice"). The Notice to NCH should be addressed to:
Legal Department
NCH Software, Inc.
6120 Greenwood Plaza Blvd, Ste 120
Greenwood Village CO, 80111
USA 
("Notice Address"). The Notice must (a) describe the nature and basis of the claim or dispute; 
and (b) set forth the specific relief sought ("Demand"). If NCH and you do not reach an 
agreement to resolve the claim within 30 days after the Notice is received, you or NCH may 
commence an arbitration proceeding. The amount of any settlement offer made by NCH or you 
shall not be disclosed to the arbitrator.

A. The arbitration will be governed by the Commercial Arbitration Rules and the Supplementary 
Procedures for Consumer Related Disputes (collectively, "AAA Rules") of the American 
Arbitration Association ("AAA"), as modified by this Agreement, and will be administered by the 
AAA. The AAA Rules are available online at adr.org, by calling the AAA at 1-800-778-7879, or 
by writing to the Notice Address. The arbitrator is bound by the terms of this Agreement. All 
issues are for the arbitrator to decide, including issues relating to the scope and enforceability 
of the arbitration provision. Unless NCH and you agree otherwise, any arbitration hearings will 
take place in Greenwood Village Colorado. If your claim is for $10,000 or less, we agree that 
you may choose whether the arbitration will be conducted solely on the basis of documents 
submitted to the arbitrator, through a telephonic hearing, or by an in-person hearing as 
established by the AAA Rules. If your claim exceeds $10,000, the right to a hearing will be 
determined by the AAA Rules. Regardless of the manner in which the arbitration is conducted, 
the arbitrator shall issue a reasoned written decision. NCH will pay all AAA filing, 
administration, and arbitrator fees for any arbitration initiated in accordance with the notice 
requirements above. If, however, the arbitrator finds that either the substance of your claim or 
the relief sought in the Demand is frivolous or brought for an improper purpose then the 
payment of all such fees will be governed by the AAA Rules. In such case, you agree to 
reimburse NCH for all monies previously disbursed by it that are otherwise your obligation to 
pay under the AAA Rules. In addition, if you initiate an arbitration in which you seek more than 
$75,000 in damages, the payment of these fees will be governed by the AAA rules.

B. The arbitrator may award declaratory or injunctive relief only in favor of the individual party 
seeking relief and only to the extent necessary to provide relief warranted by that party's 
individual claim. YOU AND NCH AGREE THAT EACH MAY BRING CLAIMS AGAINST THE 
OTHER ONLY IN YOUR OR ITS INDIVIDUAL CAPACITY, AND NOT AS A PLAINTIFF OR 
CLASS MEMBER IN ANY PURPORTED CLASS OR REPRESENTATIVE PROCEEDING. 
Further, unless both you and NCH agree otherwise, the arbitrator may not consolidate more 
than one person's claims, and may not otherwise preside over any form of a representative or 
class proceeding. If this specific provision is found to be unenforceable, then the entirety of this 
arbitration provision shall be null and void.
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C. Notwithstanding any provision in this Agreement to the contrary, we agree that if NCH 
makes any future change to this arbitration provision (other than a change to the Notice 
Address) you may reject any such change by sending us written notice within 30 days of the 
change to the Arbitration Notice Address provided above. By rejecting any future change, you 
are agreeing that you will arbitrate any dispute between us in accordance with the language of 
this provision.

D. To opt out of this Arbitration Agreement and class action waiver send an Opt Out notice to 
the Notice Address stating "I am electing to opt out of the Arbitration Agreement and class 
action waiver contained in the Legal Terms applicable to my purchase of an NCH product." 
Your Opt Out Notice must include the date and proof of purchase. The Opt Out Notice must be 
postmarked no later than thirty (30) days after the date of purchase. A separate Opt Out Notice 
must be sent for each product purchased.
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Google Authorization Process on Windows XP 
and Vista
Extra steps are required to give Express Zip authorization to upload to Google Drive and/or 
YouTube when running on Windows XP or Windows Vista: 
1. Click Authorize... in the Authorization dialog. 
2. In the web page that opens, sign in to your Google account, if required. 
3. Confirm that you authorize Express Zip to access the requested features. 
4. Copy the Authorization Code  provided by Google and paste it in the Authorization 

confirm dialog in Express Zip. 
5. Click Ready to confirm that authorization is complete. 
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